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What’s New 

Cyclone 3DR 2023.1.0 is a major release that includes new features and improvements to the product, for 

both the Desktop and Touch Mode interfaces. In addition to many enhancements, the main new functions 

are: 

▪ More simplicity and flexibility for the AEC Industry 

• Significant updates for Auto-Classification in Indoor and Outdoor environments 

• BIM Alignment 

▪ Virtual Surveyor 

▪ Gridded Inspection for both Survey and AEC applications 

▪ New interoperability capacities 

• Send to Hexagon BricsCAD 

• Support of TRK data 

• Support of classification within LGS format 

• Extension of e57 support 

• Connect to Cyclone FIELD 360 in Desktop Mode 

• Connect to HxDR 

▪ New UI tools 

• Free Move new generation 

• First person navigation mode 

• Possibility to display point cloud with transparency 

• Support of multi-screens for the 3D Scene 

• Pole center extraction 

▪ Report Editor New experience: Report preview, UI and performance improvements 

▪ New script engine and functions 

▪ New tool to extract lines 

 

According to the maintenance expiration date policy, users under maintenance on 12 March 2023 may 

access version 2023.1 with no new license required. 
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New features 

Auto-Classification updates 

 

With Cyclone 3DR 2023.1 release, a new version of point cloud classification engine is embedded. This 

change allows Cyclone 3DR to offer new models for both indoor and outdoor applications: 

 
▪ Generic Indoor 

▪ Indoor Construction Site 

▪ Outdoor Heavy Construction  

 

The classification experience is unchanged within the software solution. 

 

This feature is available to users with the SURVEY or AEC or PRO licenses. 

 

New package installation 

The installation process of the pre-requisites is unchanged. Users with a previous version installed must 

install the new package to take advantage of improvements. The process is defined below. The major 

change is the version 11.6 of CUDA Toolkit that is required to run auto-classification, whereas the version 

11.2 was required for the previous engine. 

 

Before launching Auto-Classification for the first time, a notification is displayed in the menu Clean > Cloud 

classification to alert the user that prerequisites must be fulfilled before running the command. 

 

 
 

After clicking on the button, the following pop-up is displayed to explain the missing prerequisites, and to 

guide the download and the installation process. 
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The same warning will appear when prerequisites are downloaded but not installed yet: 

 

 
 

Once the download is complete, the user will be prompted to complete the process by installing the 

downloads.  

 

 
 

 

The download process of the prerequisites is isolated from the product installer for the following reason: 
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▪ It prevents users from unnecessary downloading at each new release (minors and majors). 

▪ Some computers may have already CUDA® 11.6 Toolkit installed. 

▪ Some machines may not have the minimum specifications to run the command. 

▪ Users with Standard Edition do not need to install those elements. 

▪ Some users might not use the feature. 

 

The prerequisites are: 

▪ CUDA® 11.6 Toolkit (from NVidia). The 11.6 version of CUDA is mandatory for Auto-

Classification. 

▪ Classification plugin 

▪ Classification models 

 

Since this new algorithm is based on machine learning, its capabilities require high-performance elements. 

 

The minimum computer specifications to run auto-classification are: 

 

▪ RAM: minimum 32 GB 

▪ Graphic Card: NVidia with GPU capabilities  

- Compute capability: 3.7 or higher 

- Minimum GPU memory: 4 GB 

▪ Hard Disk:10 GB free disk space 

 

The Auto-Classification tools require a NVIDIA QUADRO graphics card. If one is not detected, the following 

pop-up is displayed: 

 

 
 

New classification models 

In addition to the existing model for Outdoor application, the Auto-Classification feature exposes three new 

models. To execute a classification, the workflow is unchanged, and the steps are: 

 

https://developer.nvidia.com/cuda-gpus
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▪ Select a point cloud (JetStream point cloud must be converted first). 

▪ Go to Clean menu. 

▪ Launch Auto-Classification 

▪ Choose the appropriate model 

▪ Click Preview to run the computation, then OK to validate the results. 

 

 

Indoor for Generic Application 

 

This new model is appropriate to classify point cloud data captured in an Indoor environment. Since the 

model is dedicated to generic applications, it is recommended for use in existing environments for Scan to 

BIM, renovation and digital twins in environments like offices, residentials and public facilities. 

 

This Generic Indoor model replaces the previous Indoor model. It can be used for point clouds captured 

with any sensor and it delivers a point cloud that can contain up to 37 classes. They are detailed in the 

“Settings” within Cyclone 3DR. 

 

 
Office environment classified with previous Indoor model 
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Office environment classified with new Generic Indoor Classification 

Objects like floor, doors, ceiling, ceiling equipment, walls, chairs, tables, columns are clearly defined 

 

Indoor Construction  

 

This new model is appropriate to classify indoor point cloud data in active construction zones. The main 

application for this classification model is preparation and data cleaning to deliver accurate verification and 

analysis (structure, MEP, distributions, etc.) 

▪ Surface analysis 

▪ Inspection vs design 

▪ Clash Analysis 

▪ Progress Monitoring 

 

The Construction Site model can be also used for data cleaning to deliver cleaned mesh model for visual 

inspection/verification or to deliver models to 3rd party applications. 

 

The indoor construction classification model will identify not only structural objects such as walls doors, 

ducts etc. but also construction equipment and debris for easy removal from the scene. 
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Construction site capture with RTC360 (shopping center) 

 

 
After classification with Indoor model for Construction Site 

Objects like floor, doors, ceiling, ducts, pipes, worksite equipment, beams, columns are clearly defined. 

 

Outdoor for Heavy Construction Application 

 

This new model has been trained with UAV sensor datasets but can be used with point clouds from any 

sensor corresponding to Heavy Construction environments. This new model is relevant to prepare datasets 

for many workflows in 3DR: 

▪ DTM 

▪ Stockpile 

▪ Cross-Section analysis 

▪ Slope monitoring 

▪ Volume calculation / Cut and Fill calculation 
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Stockpile site classified in 1-click in Cyclone 3DR with the new Heavy Construction UAV model 

Trucks, stockpiles, buildings, grounds, artefacts are automatically classified. 
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Settings 

Classification settings are updated with the 2023.1 release of Cyclone 3DR. The pre-defined parameters 

have been adjusted to match with the classes related to the embedded classification models within Cyclone 

3DR and all Hexagon solutions in general. It means that there is now a unified standard (indexes, names 

and colors) within Hexagon products. 

 

Since personal settings are saved when a new version of Cyclone 3DR is available, it is recommended 

to restore the default settings for classification when installing the 2023.1.0 version. For this new 

release, a specific feature has been added to restore the Hexagon standard settings for classification. 

 

It is highly recommended to use the Hexagon standard classification settings for workflows using classified 

LGS from Cyclone REGISTER 360 PLUS or from Cyclone PEGASUS Office to facilitate the experience 

between the Hexagon products. 

 

 
 

New “HEXAGON standards” restoring feature in Cyclone 3DR classification settings 
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Manual Classification > Pick class 

Users can now query the classification of any point within a project. This new capacity is helpful to 

understand complex datasets with many classes. 

 

▪ Select one or multiple classified point cloud(s) 

▪ Run Manual Classification in the Clean menu 

▪ Click on the new button Pick class to activate the new mode 

▪ Click on a point in the 3D Scene to get the information 

▪ The corresponding class is highlighted in the list 

 

 
 

This feature is available to users with the SURVEY or AEC or PRO licenses. 

 

Coord Sys > BIM Alignment 

With the 2023.1 release, the new BIM Alignment feature gives a user-friendly way to align a design model 

with a point cloud data in a few clicks. This feature has been designed for the construction industry and 

can be applied for diverse design models like Mesh, CAD or BIM models. This new functionality is useful 

as a start of any analysis workflow involving a design model for AEC applications like a construction 

verification, a clash analysis or a progress monitoring. 

 

The process is to execute the BIM Alignment is the following: 

▪ Select both inputs: the point cloud and the design model (BIM, Mesh or CAD) 

▪ Go to Coord Sys menu and click on BIM Alignment. 
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The feature automatically splits the 3D scene in two parts: one 3D scene for each object of the 

project. 

 

 
 

1. Choose which object to move (point cloud of design model). The other one will be fixed. 

2. Note that it is possible to benefit from the new Multi-Window capacity of the 2023.1 release of 
Cyclone 3DR to deploy a 3D scene and to shift it into a second screen for example, to increase 
the size of the windows and to improve the experience. This new interface capacity is described 
in the release notes. 

3. Apply the instructions: 

On the moved object: one click on a vertical wall + one click on a reference point. 

On the fixed object: one click on the same vertical wall + one click on the same reference point. 

 

It is recommended to first adjust the views of the two 3D scenes at the same position and with the 

same orientation to click on similar objects. Note that the clicks on the vertical wall do not need to 

be precise because the purpose is to get the normal direction, whereas the click on the reference 

points must be precise enough so it is recommended to click on a corner that is easy to recognize. 

 

Tip: prior to launching the BIM Alignment feature, create a limit box or slice around one object (the 

targeted fixed object for example) and use the shortcut CTRL+SPACE inside the command to edit 

it and get the best view to navigate through complex BIM models. 

 

4. Temporary UCS are then displayed on each scene as an indication. Click on ENTER as requested 

in the instructions (screenshot below). 

 

2 

1 

3 
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5. The pre-alignment of the moved object to the fixed one is automatic and extremely fast. Next and 

final step of the workflow is the best-fit operation. 

 

 
6. In case it is necessary to redo a pre-alignment, click Reset. 

7. The exposed options for the best-fit operations are very simple and composed of: 

The attraction distance (default 5 cm): the points that are not closer to that distance are 
not considered in the best-fit operation. It is a way to remove noisy points from the 
operation but also to focus on the common areas of the two objects. 

Checkbox option to preserve the vertical axis: in most cases for building applications, 
scans are properly leveled, and its Z orientation should be maintained during the best-fit 
operation. 

Note that the alignment process is similar to the alignment feature of the BIM Inspection 

6 

7 

8 
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in Cyclone 3DR Touch Mode. The same experience is deployed in the Desktop mode of 
Cyclone 3DR 2023.1. 

 

8. Click on preview to execute the best-fit operation. 

Results of the transformation are summarized in the dialog box. 

 
 

Click on OK to validate. It is at this point that the two objects are finally aligned and ready to finalize 
the workflow with a comparison analysis. 

 

This feature is available to users with the AEC or PRO licenses. 
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Coord Sys > Free Move new generation 

With the release of the Cyclone 3DR 2023.1 the Free Move has been improved with greater usability, 

responsiveness, support for undo/redo, the possibility to translate objects in a plane and the capacity to 

enter numerical values for translation and rotation. 

 

The Free Move feature can be used to conduct a pre-alignment of multiple objects: 

 

▪ To do a manual pre-alignment for a BIM application or positioning of an object in a 3D environment. 

▪ To position and orientate a design model of a piece of equipment in a real environment for any 

kind of application like the construction or the mining industry. 

 

  
 

The name of the feature, Free Move, is unchanged, and it is just necessary to select the object prior to 

running the Free Move tool.  

 

Once started, a 3D widget is displayed at the center of the object. 

 

 
 

The features are the following ones: 

▪ Long arrows along main axis of the active UCS: 

• Drag and drop on the arrows to proceed a translation along the selected axis. Ability to define 

a numerical value for translation when pressing keyboard TAB. 

• Single click on the arrows to open the vector toolbar and reposition the axis of the widget. 

▪ Curved arrows around the main axis of the active UCS: drag and drop on the arrows to proceed 

a rotation around the selected axis. Ability to define a numerical value for rotation when pressing 

keyboard TAB. 
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▪ Short white double arrows at the extremity of each axis of the axis UCS: drag and drop on 

the double arrows to resize the object. 

▪ Planes aligned on main axis: drag and drop on the selected plane to translate the object onto 

the selected planes. 

▪ Center ball: 

• Drag and drop the center ball to do a 2D move of the object in the scene (translation in the 

plane corresponding to the scene view) 

• Single click on the center ball and then click on a specific point on the object to reposition the 

widget in an area that may be more appropriate to do the free move operation (relevant for 

large object and to focus on a specific area). Available with keyboard shortcut “C”. 

 

        
 

The Free Move widget is repositioned in the corner of the building. 

 

▪ CTRL+Z: to undo the last action 

▪ CTRL+Y: to redo the last action 

▪ ESC: to quit the command and cancel the changes 

▪ TAB: to define a numerical value when doing a translation or a rotation 

▪ ENTER: to quit the command and validate the changes 

 

Note: the edition of geometrical features (like cylinders, cones, circles, …) has been adapted to use the 

same 3D scene widget to facilitate the edition of the objects (dimensions and main axis). 
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Example of a best cylinder of a small Tank of a Chemical Plant – Edited with new widget 

 

This feature is available to users with the STANDARD license. 

 

Extract > Virtual Surveyor 

With the release of Cyclone 3DR 2023.1 a new Virtual Surveyor feature allows users to create traditional 

survey maps in CAD format from any kind of 3D data. This feature adapts the popular tool from Cyclone 

SURVEY into Cyclone 3DR Survey Edition for users switching to the next generation solution. 

 

Virtual Surveyor offers a very flexible workflow which allows it to be used from multiple objects like point 

clouds (including LGS, JetStream data or HxDR point cloud), meshes or design models and allows a 

project to be closed and validated and then revisited later.  

 

Starting Virtual Surveyor for the first time, the following empty dialog is displayed. It is necessary to define 

the settings of the Virtual Surveyor project from the button illustrated below. 
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1. Go to Virtual Surveyor settings 

2. Layer management – Add new layer 

This section gives the capacity to create different layers and their parameters (colors and pixels). 

3. Layer management – Load and Save 

With the capacity to save the layers to a CSV file, users can properly store their predefined settings 
for specific applications, for different types of customers or for different regional needs. It provides 
an easy way to share the list of layers with other stakeholders or colleagues. 

4. Feature Code management – Add new feature code 

For each layer, users can then define precisely different Feature Codes: Layer, Description, Min 
Index and type of objects (point or polyline). 

5. Feature Code management – Load and Save 

Similar capacities and benefits as the management of layers to save, store, reuse or share 
predefined settings of Feature Codes. 

 

Once the settings are properly defined, they can be completed later again during the project, and it is 

possible to build a CAD Survey map in the main command: 
  

3 

2 

4 
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1. Create a new object Point or Polyline: 
when active, this feature enables a drop-
down list to make the user choose the 
appropriate Feature Code. 

2. Filter Layers: to show/hide and 
activate/deactivate layers for new 
objects 

3. Edit object: change Feature Code, Edit, 
Copy, Zoom on or Delete 

4. Option to hide/show texts: to display the 
feature code naming in the 3D Scene 

5. Export options including 

a. Export to DXF or CSV 

b. Direct Send to CAD feature 
(including now BricsCAD in 
addition to AutoCAD and 
MinePlan) 

6. Click OK to save the project and go back 
to the main environment. 

 

 
 

CAD Survey map in construction for a parking lot 

 

To restart a project users have two options: 

▪ Select the Virtual Surveyor folder in the treeview and click on Virtual Surveyor in the Extract menu. 

▪ Click on the “Play” icon close to the folder name directly in the treeview. 

 

This capacity to start, close and reopen a Virtual Surveyor gives users more flexibility. It also provides the 

capacity to show/hide objects of interest, or to change some representations. As an example, in the 

1 

2 

3 

4 

5 
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illustration above, the trees and random outdoor objects are displayed with their classification 

representation, whereas the ground area and the buildings are displayed in real colors. That is appropriate 

to have a better visibility of the areas of interest to create the Feature Codes. 

 

Note: A new “Pole Center” is released with the 2023.1 version of Cyclone 3DR in the point selection 

toolbar. This functionality is appropriate for Virtual Surveyor and is described in the 3D Scene > New 

experience chapter of the release notes. 

 

This feature is available to users with the SURVEY or PRO licenses. 

 

Analysis > Gridded Inspection 

Cyclone 3DR 2023.1 offers a new option within Surface Analysis: Gridded Inspection. The new feature 

offers the capacity to create customized grids that contain inspection values for  reporting and decision 

making. 

 

Gridded Inspection is applicable to the Surface Analysis tools, Surface Levelness, Surface Flatness and 

Slope Analysis, and brings a significant improvement for the various applications that were already 

possible with Cyclone 3DR: 

 

▪ Floor Flatness / Floor Levelness mainly for the AEC Industry 

▪ Wall verticality for AEC or Heavy Construction industry 

▪ Slope reporting both for the Construction Industry (verification of existing floors), Heavy 

Construction (verification of piles, slopes, worksites, Surveying (landscape monitoring) 

▪ Surface verification for Manufacturing application (agnostic to any kind of fabricated 

products) 

 

  
Gridded Floor Levelness inspection Estimation of thickness for the future plaster layer after the 

construction of the wall 
 

 

The Gridded Inspection feature can be executed by two means with the same interface and same options: 

1. Directly from the existing Surface Analysis tools by checking the new option 
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2. Or from an existing analyzed mesh models from the new feature in Analysis menu > 

Gridded Inspection (after selecting the input analysis) 

 

 
 

The workflow is described below: 
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1. Define the parameters of the grid (origin, axis and dimensions). 

2. Click Preview to run the computation. 

3. Click Edit Colors to adjust the parameters of the grid. New options are proposed for this specific 
feature for the most appropriate visualization in the 3D scene or in the printed report (depending 
on the application). Many options are exposed for more flexibility for users. 

 
 

4. Export to 3rd party CAD application before validating the results: 

3 2 

1 

4 
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a. Ability to define the size of the text of the values. 

b. Export directly to DXF or to CAD application like AutoCAD or BricsCAD. 

 

 
Floor Analysis sent to BricsCAD 

 

After validation, the outputs are: 

▪ A point cloud: 

a) Distributed on a grid 

b) Colorized according to inspection values 

c) With inspection values displayed as texts 

▪ A report chapter, related to automatic viewset, to share the results for decision making. 

 

The representation of the point cloud can be edited after results are calculated via the Edit Colors feature 

(available for all inspection projects in Cyclone 3DR) to improve the legibility of the results. 

 

 
 

This feature is available to users with the SURVEY or AEC or PRO licenses. 
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New interoperability capacities 

Send to / Send From BricsCAD v23 (Hexagon) 

Part of the interoperability new features, the direct connection to Hexagon software product BricsCAD is 

now embedded in Cyclone 3DR. The feature is compatible with BricsCAD v23 and future versions of the 

CAD solution. 

 

This feature can provide lots of time saving in workflows involving the two products for mesh model 

creation, reverse engineering, 2D and 3D extraction for engineering applications, and also gives the 

capacity to save layer information for specific 3DR projects (section added in the last chapter “Leica 

Cyclone 3DR supported file formats”). 

 

The objects that are compatible with the BricsCAD interoperability are detailed in Cyclone 3DR 

Documentation Center and covers mainly: mesh models, CAD models, polylines, geometries (cylinders, 

rectangles, planes), orthoimages and specific 3DR projects (Scan to Plan, Contour Lines, Virtual Surveyor, 

Gridded Inspection, Extract orthoimages). 

 

The data exchange experience is exactly the same as the existing one for Autodesk AutoCAD and 

Hexagon MinePlan.  

 

  

Building Extractor use case to monitor the construction of 
a residential building 

 

Extracted model sent from Cyclone 3DR to BricsCAD 
using File Menu > Send to feature 

 

 

 

From Cyclone 3DR to BricsCAD:  

 

There are three methods to export Cyclone 3DR deliverables to BricsCAD.  

 

Note: The user must have an active BricsCAD project on the same local machine. 

 

1. From contextual menu in 3D Scene after selection of the inputs and right click: 

https://cyclone3dr.leica-geosystems.com/help/2023.1/HelpCenter.html
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Wall plumbness analysis that can be exported to BricsCAD 

 

2. From File menu and Send To feature after selection of the inputs: 

 

 

 

 
1. Select the Send To feature 

2. Select a product from the list of available 
servers, now including BricsCAD 

3. Optionally select the checkbox to export 
the project in the active UCS or not  

4. Select the Send button 

 

 

 

3. From a specific Cyclone 3DR project among the following ones 

 

1 

2 

3 
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Menu Feature Comment 

Extract Contour Lines 
1 layer for standard contour lines and values. 

1 layer for major contour lines and values. 

Extract Scan to Plan 1 layer per slice (floorplans or sections) 

Extract Virtual Surveyor 
1 layer per layer created in 3DR Virtual Surveyor 

project. 

Analysis 
Gridded Inspection 

Surface Analysis with a Grid 

Points and values on grid can be directly sent to CAD 

SW product. Sent to active layer. 

Texturing Extract Orthoimage Sent to active layer. 

Analysis 

2D Preview Export 

1 layer for 2D Grids 

1 layer for inspection objects 

1 layer per section 

1 layer per axis points 

1 layer per axis point quotations. 

Coord Sys 

Tank 

 

  
Floorplan from a 3DR Scan to Plan project of a residential 

application 
Floorplan is directly sent to BricsCAD v23 

 

 

From BricsCAD to Cyclone 3DR: 

 

The workflow is extremely simple: 

1. Make sure Cyclone 3DR is launched 

2. Select the objects to send to Cyclone 3DR 

3. Open Cyclone 3DR Plug-in menu and click on Send To Cyclone 3DR 

4. Project is available in Cyclone 3DR 
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2D CAD Plan designed in BricsCAD 

 

 
2D CAD Plan directly sent to Cyclone 3DR 

 

This feature is available to users with the STANDARD license. The users must also own a BricsCAD V23 

license. 
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Support of LGS from TRK scanners 

 

Cyclone 3DR 2023.1 can import LGS and JetStream scan data captured with the new TRK sensors 

published from Cyclone Pegasus OFFICE. 

 

The capacities to consume LGS data from TRK sensors are the same as for the other Reality Capture 

sensors.  

▪ Streaming and visualizing very large point clouds, relevant for 3D environment capture with Mobile 

Mapping technologies (real colors, intensity and classification) 

▪ Converting project (point cloud and images): it is recommended to define an area of interest, using a 

clipping object prior to the conversion of the project into a 3DR point cloud. 

▪ Using point selection and smart picking tools (highest point, lowest point, ground point) without data 

conversion 

▪ Running features without conversion (Scan to Mesh, Virtual Surveyor, Stockpile Analysis) 

 

The support of LGS and JetStream data captured with TRK scanner benefits many industries related to 

MMS including Road, Rail and Heavy Construction. In particular, with the release of the new Virtual 

Surveyor working on native LGS, users can quickly and smoothly deliver Survey CAD Projects from TRK 

scanners to CAD solutions using Cyclone 3DR. 

 

Note 1: For the full integration of MMS data, a new script function SCWCloud.ToMMSData() has been 

added to extract a point cloud from LGS data delivered by Cyclone PEGASUS OFFICE. 

 

Note 2: Trajectory and image navigation along trajectory from TRK scans are not supported in Cyclone 

3DR 2023.1. 

 

 

This feature is available to users with the STANDARD license. 
 

Support of classification within LGS 

With the 2023.1 release of Cyclone 3DR, the LGS workflow is significantly improved to offer the best 

experience across all the Reality Capture solutions of Leica Geosystems. 

 

In particular, the classification can now be properly saved and shared thanks to the recent releases of the 

diverse software products like Cyclone REGISTER 360 PLUS, TruView and Cyclone Pegasus OFFICE. 

These improvements include: 

▪ Harmonized representation settings and classification parameters across the Reality Capture software 

portfolio 

▪ Support of classification within a LGS point cloud after IMPORT: 

a) Classification is visible prior to point cloud conversion 

b) Classification is saved after conversion of the point cloud into 3DR point cloud engine 

▪ Support of classification within LGS after EXPORT 
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Urban environment captured with a TRK sensor displayed in Cyclone 3DR 

Without conversion of the LGS scan data 

 

After the point cloud conversion, it is also possible to use the classification features like Automatic 

Classification, Manual Classification, Explode by Class and Group (and save the classification information) 

of the converted point cloud. 

 

Users may wish to combine an existing classification with the tools present in Cyclone 3DR for a more 

advanced analysis or visualization. 

▪ Import classified LGS into Cyclone 3DR 

▪ Convert the area of interest and proceed cleaning of point cloud using smart tools like Explode by 

Class and other features 

▪ Merge into a single point cloud and export it to LGS 

▪ Import it into Cyclone ENTERPRISE for visualization and project management 

 

This feature is available to users with the STANDARD license. To run automatic classification, SURVEY, 

AEC or PRO licenses are required. 

 

Extension of Import/Export e57 

With the 2023.1 release of Cyclone 3DR, the support of the standard e57 benefits from a significant 

improvement that offers new capacities to users. 

 

The new features are the support of: 

▪ Point cloud classification is preserved at import and export: relevant to use the intelligence of 

classification for a smart cleaning of data to do a 3DR project 

▪ Point cloud scanning directions are preserved at import and export: relevant form mobile 

mapping applications 

▪ Point cloud timestamps are preserved at import and export: relevant for mobile mapping 

applications 
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▪ Pre-existing Images are preserved at import and export: relevant to preserve full information for 

Digital Reality workflow across many products 

▪ Faster import in general 

 

FEATURES IMPORT EXPORT 

Classification New in 2023.1 New in 2023.1 

Images Existing New in 2023.1 

Timestamps Existing New in 2023.1 

Scanning directions 
Existing for TLS sensors 

New in 2023.1 for MMS sensors 
New in 2023.1 

 

 

Since e57 format is the most popular and standard format for point cloud across the Reality Capture 

business ecosystem, this feature is a very important benefit for workflows involving: 

▪ Third-party sensors (not part of the Hexagon family) 

▪ Cyclone 3DR for all its tools (cleaning, meshing, analysis and modelling). 

▪ Third-party application that can consume Cyclone 3DR deliverables: 

• Cleaned 3D data: cleaned and classified point clouds, images, mesh models 

• 3D inspection models 

• 2D or 3D extracted models 

 

This feature is available to users with the STANDARD license. 

 

Connect to Cyclone FIELD 360 

With the release of Cyclone 3DR 2023.1, direct connection to Cyclone FIELD 360 is now possible in 

Desktop Mode, in addition to the existing capacity in Touch Mode (BIM Inspection workflow). 

 

This feature enables the capacity to realize a quick import of a point cloud from the tablet to an office 

machine to benefit from Cyclone 3DR capacities. 

 

To start the connection, the requirements are similar to the existing feature in Touch Mode: 

▪ Connect the two devices (tablet with Cyclone FIELD 360 and the machine with Cyclone 3DR) on the 

same wireless network. 

▪ Active the Sync Server mode in Cyclone FIELD 360 

 

Then in Cyclone 3DR, go to File menu and Click on Import to display the new feature icon. 
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Note: As illustrated in the image above, the Load from BLK feature is now removed from the application. 

The new Import from FIELD 360 replaces this feature. This change provides many advantages in 

comparison to the previous capacity: 

▪ A complete BLK360 project can be loaded in Cyclone 3DR instead of a scan-by-scan process (with no 

registration before) 

▪ All the sensors that are supported by Cyclone FIELD 360 can be accessed with this command. 

 

Once the connection started, the feature displayed a couple of fields to enter the IP address information of 

the tablet that hosts Cyclone FIELD 360. Fill the appropriate values and click Connect. 

 

 
 

After connection, the list of available projects is displayed with: 

 
1. Project information 

2. Refresh connection 

3. Import point cloud 
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▪ During import, the Sync Server feature must remain active in Cyclone FIELD 360 until the point cloud 

is imported in Cyclone 3DR. 

▪ The complete point cloud project is imported: all the pre-registered bundles are transferred to Cyclone 

3DR application. 

▪ The point cloud is automatically converted into Cyclone 3DR point cloud structure. That means that no 

conversion step is required and all the 3DR functionalities can be used. 

▪ The original point cloud structure depends on the kind of sensors and of the parameters of Cyclone 

FIELD 360 projects. The Import feature looks for the following structure by order of priority: 

a) Full data 

b) Light weight LWPO data 

c) LiDAR data (if an Apple LiDAR scan is part of the project) 

 

 

This new connection feature is complementary to the regular workflow (using Cyclone REGISTER 360 

PLUS or LGS format). The advanced workflow indeed provides the complete dataset into Cyclone 3DR, 

including the images or the classification information. The FIELD 360 workflow is appropriate to get a very 

quick deliverables from the field to the office, to execute for example a rough DTM, a simple digital model 

with Scan to Mesh or a floorplan with Scan to Plan. 

 

This feature is available to users with the STANDARD license and with a Cyclone FIELD 360 credentials. 

 
  

1 

2 

3 
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Connect to HxDR 

With the 2023.1 version of Cyclone 3DR, the connection to HxDR cloud is now enabled. This new feature 

allows users to connect to HxDR and visualize point cloud assets hosted in HxDR and to convert it into 

Cyclone 3DR point cloud conduct a Cyclone 3DR analysis. This feature allows users to leverage the power 

of HxDR to work on shared point clouds hosted in the cloud. 

 

All data and project access in HxDR is protected by user credentials, allowing admins to provide secure 

access to specific users.  

 
1. Navigate to the File menu and select Connect to HxDR  

 

 
 

2. Once connected, the list of projects is displayed. 

 

 
 

a. Connection management: access to credential management and refresh 

b. Search bar and tools of projects (including refresh and filter) 

c. List of project information 

a 

b 

c 

d 
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d. Direct access to HxDR website 

3. After clicking on a project, the contained assets are displayed: 

 

 
 

a. Search bar and tools of assets (including refresh and filter) 

b. List of asset information 

c. Import point cloud asset 

4. After clicking on Import, the point cloud is automatically loaded and streamed in 3DR Project. 
Parameters of the point cloud object are available and visible (illustration below). 

 

 
 

The HxDR streaming experience is analogous to streaming a JetStream project. Users can navigate with 

all Cyclone 3DR tools, make basic measurements, click on points to define a clipping object, and display 

the area of interest. 

 

The next step for a complete HxDR - Cyclone 3DR workflow, after defining an appropriate clipping object 

(optional to reduce the area of interest for very large point clouds), is to convert the HxDR point cloud into 

a Cyclone 3DR point cloud structure. Only the visible points are converted with: 

▪ A right click > Convert Project (from the treeview or the 3D Scene) 

▪ From the Extract menu > Convert from HxDR feature 

 

The Convert Project experience is simple with a definition of the maximum number of the visible points 

that can be converted (right image below). 

 

c 

a 

b 
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Note that the credential management is permanently accessible on the top right of the main Cyclone 3DR 

window (illustration below). 

 

 
 

 
Example of BLK2FLY urban dataset streamed in Cyclone 3DR 

 

Like the JetStream experience, the number of simultaneous streamed point cloud is limited to a single 

point cloud. Therefore, it is necessary to convert a first point cloud asset and then and closing the project, 

prior to streaming a second project. 

 

This feature is available to users with the STANDARD license and with Cyclone 3DR Viewer. HxDR 

Credentials are required. 
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3D Scene > New experience 

The new 2023.1 version of Cyclone 3DR offers a large series of new capacities of the 3D Scene experience 

that brings more comfort for users working in complex 3D environments. The following new features are 

described in the chapter: 

 

▪ Support of multi-windows 

▪ First Person Navigation mode 

▪ Transparency management of point cloud 

▪ Rendering of inspected models 

▪ Point selection toolbar > New Pole Center extraction 

 

Viewport > Multi-window support 

The existing feature Viewport from the View menu provides a significant improvement with the capacity 

to dock and undock multiple new windows. To benefit from the new experience and to use the Viewport 

capacities, begin by using the existing Viewport feature. 

 

 
 

After the creation of a new view, users can define a specific and different view and to choose which objects 

are displayed in the 3D Scene. 

 

From the top bar of each view, new icons are exposed to (illustration below): 

 

▪ Close the scene 

▪ Dock/undock the scene 

▪ Duplicate the scene and choose a pre-defined position (bottom, left, right, top) 
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The capacity to dock/undock a 3D Scene is a significant improvement that gives users flexibility to position 

the different views where it is convenient for the most comfortable experience. The image below illustrates 

the “Scene 2” that has been undocked and that is displayed in front of the main screen of Cyclone 3DR. 

The illustration also highlights the capacity to redock a floating screen onto a pre-defined position with 4 

widgets (top, bottom, left and right) that are visible and active when doing a drag and drop of the floating 

scene from the top-bar. 

 

 
 

Depending on the number of views, another central widget can be displayed in the middle of one view, in 

addition to the 4 position widgets, to reposition the floating scene according one of the views instead of the 

main global window of Cyclone 3DR. In the image below, the Scene 3 can be repositioned according to 

the scene 2. 
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To illustrate the power of this new experience, the final image below illustrates a inspection project that is 

displayed on 2 computer screens, showing for each scene a different object: colorized point cloud, 

deviation analysis, BIM Model and a single color point cloud. 

 

 
Cyclone 3DR with 4 undocked 3DScene view on 2 different screens 

 

This new feature can help for all the applications of Cyclone 3DR, for users working with multiple screens. 

Some examples of usage can be: 

 

▪ Visual Inspection: 

i. same object at different timing (different scans of same environment, or different 

analysis jobs of the same situation) 

ii. different object for the same situation 

▪ 3D Navigation for the best understanding as possible of the digital environment to create views, 

measures, labels or to create different layers of representations. 

 

This feature is available to users with the STANDARD license. 
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First Person Navigation mode 

In the navigation toolbar, Cyclone 2023.1 introduces the First Person Navigation mode. This new 

navigation capacity is extremely relevant for Indoor application and gives users new tools for smooth 

navigation with the mouse and the keyboard. 

 

 
 

All the tips and the instructions are detailed in the Document Center. The main new capacities are the 

following ones: 

▪ One-left-click mouse to reposition the camera view and orientation at a relevant distance from the 

click to offer a human-like experience in the 3D environment.  

a) On a floor to position the camera view above the click 

b) On a wall to be positioned in front of the wall 

c) On a ceiling to be positioned below with the appropriate orientation 

 

 
 

▪ Main arrows on keyword to move forward or backward and to turn right or left. 

 

First Person Navigation mode requires the normal of the clicked object to position the camera position and 

orientation. Thus, this feature is not available for JetStream point cloud (LGS). 
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This feature is available to users with the STANDARD license. 

Rendering > Transparency mode of point cloud (X-Ray representation) 

With the 2023.1 release of Cyclone 3DR, a new transparency mode is available for point clouds. The 

transparency level can be managed from the treeview: 

 

 
 

In addition to a pleasant and easy navigation through the software product, this new feature can provide 

an amazing visualization experience and is appropriate for many applications: 

▪ Manipulation of object in the scene. With Free Move, it is possible to conduct an efficient pre-alignment 

before best fit between a model. 

 

  
Pre-alignment in 2 steps (Top and Side views) 

▪ Video creation with the feature View > Camera path can provide a very attractive visual effect.  

▪ High Resolution images creation with View > Capture View (examples below) 
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▪ Highly detailed ortho-image creation with Texturing > Extract Orthoimage, which is typically relevant 

for floorplan or section creation. 

 

  
Foorplan or sitemap for a Heritage application 

 

 
Section of an old house 

 

Note that transparency mode is demanding on the Graphics card when it’s activated. It is recommended 

to lower the points display density or limit the number of transparent elements to maintain a high frame 

rate. 
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This feature is available to users with the STANDARD license. 

 

Rendering > Inspected models 

Cyclone 3DR offers now a much more realistic rendering of inspected models. 

 

The illustrations below demonstrate that the new higher quality rendering with better management of color 

transition, which is extremely important to analyze inspection results (tolerance / out of tolerance areas as 

an example). 

 

This feature serves all the inspection workflows that involve a surface model (CAD, BIM, Mesh, Geometry). 

It is mandatory to apply the result colors on the surface model to benefit from the new rendering. 

 

Cyclone 3DR 2023.0 Cyclone 3DR 2023.1 

  

  
Difference of rendering of inspected models showing more realistic details with the new release 

 

This feature is available to users with the STANDARD license. 
 

Point selection toolbar > Pole Center extraction 

For the benefit of the new Virtual Surveyor feature, a new way to extract points in the Point Selection 

toolbar is available with the 2023.1 version of Cyclone 3DR: Pole Center. 

 

With a search radius parameter, this new feature allows users to extract the center position at the bottom 

of a pole-like object (road signs, poles, trees). 
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1. Make sure Pole Center mode is activated 

2. Define the Search Radius 

3. Click on a point on the pole in the point cloud where the pole is well defined 

4. Point is automatically extracted in the middle of the pole and projected on the ground 

 

The feature is enabled with the point selection toolbar across the product interface. Thus, the new feature 

is not limited to the new Virtual Surveyor feature, but it can be used for other applications too. This new 

point extraction tool is not compatible with JetStream (LGS or Cyclone ENTERPRISE) or HxDR point 

clouds. 

 

 
 

Feature codes marking the center of a group of trees in a parking lot 

 

This feature is available to users with the SURVEY or PRO licenses. 

1 2 

3 

4 
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Report Editor > New experience 

A series of improvements have been made to the report editor with the 2023.1 release of Cyclone 3DR. 

The improvements come mainly from customer feedback. 

 

This feature is available to users with the STANDARD license. 

 

Report Live Preview 

In addition to the template that is part of the main screen of the report editor, a faithful and live rendering 

of the future printed PDF is useful to improve the experience of the report creation. With the 2023.1 release, 

a Live Preview of the PDF report is automatically generated as the user adds and removed components. 

 

 
 

1. Activate Live Preview  

2. Faithful PDF preview is automatically displayed 

 

In addition to this new capacity, the Live Preview mode benefits from the new capacity to create multiple 

windows. Therefore, this PDF preview can be un/docked from the main window, which is extremely 

convenient to double check the created report. It is recommended to deploy the preview on a second 

screen for the best experience possible. 

 

1 

2 



 

46 
 

 
 

The preview can be undocked and positioned wherever it is convenient 

 

 

Generic updates for Report Editor 

 

▪ Capacity to sort label values according to a specific column 

1. Select the table 

2. Check the option Sort by and choose the appropriate column. Choose the sorting order. 

 

 
The values are sorted by 3D Deviation values (from the highest to the lowest). 

1 1 

2 
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▪ Drag and Drop images from Windows Explorer into the 3DR Report Editor: time-saving feature to 

add user images. 

▪ Better default organization of chapters: when there are multiple chapters, they have the same 

names as the analysis in 3DR project and sorted in the same order as the one used for the creation 

of the different analysis 

▪ Better management of 3D objects: when an object of the project is changed, its parameters are 

properly saved in the report. 

▪ Default name of a printed PDF report is the same as the 3DR project name. 

▪ Better visual aspect of inspected models (mesh, BIM or CAD) in printed 3D PDF (more realistic 

and clearer drawing of gradient limits). 

 

Performances 

With the 2023.1 release, performance of the navigation through the report editor has been significantly 

improved to reduce the time of loading the different pageviews in the report editor (cover, different 

chapters) and the transition time from the main 3D scene to the report editor. 

 

Time performance has been improved up to 10 times. 

 

Extract > Line Region Grow 

With the 2023.1 version of Cyclone 3DR, users can now extract lines from 3D objects with the Region 

Grow feature for line extraction. A new algorithm has been developed to extract the best line from an object 

with one click. 

 

To execute the feature, no input selection is required. The new feature can be launched from the Extract 

menu, in the Line group, Region Grow feature. 
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Pole Best Line extraction from a single click in the 3D Scene 

 

The mechanism for the Line Region Grow feature is the same as the other existing Region Grow features 

(Cylinders, Circles, Rectangles, …). The different aspects of the command are detailed below. Like the 

other Region Grow features, the steps from 1 to 4 can be executed in a random order: 

 
1. Define a tolerance of extraction 

2. Click once on an object in the 3D Scene 

3. Option to force the parameters of the extracted Best Line (Center and Axis) 

4. Outputs (Line, Extracted Cloud, Label) 

5. Information on Region Grow operation 

6. Click OK, Next to start a new Region Grow Line extraction or OK, Exit to go back to the main 
environment. 

 

The applications for this new feature range from outdoor Surveying applications to manufacturing, 

construction and reverse engineering—any situation where a geometric axis is required to achieve the 

workflow in Cyclone 3DR. 

 

3 

1 

2 

4 

5 

6 
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Axis of poles extracted in 1-click from Line Region Grow with OK, Next capacity 

 

This feature is available to users with the STANDARD license. 

 

 

 

  



 

50 
 

Script > New engine 

The 2023.1 release of Cyclone 3DR embeds a new engine for the script module to address a technical 

limitation. 

▪ First, there are many improvements that accompany this engine migration. They are described in the 

following chapter. 

▪ Secondly, this migration of engine brings some changes in the script creation experience. This aspect 

is covered in detail in the documentation center and briefly introduced in the release notes. 

▪ Finally, this migration resulted in the depreciation of a group of functions. They are detailed in the 

chapter. 

 

This feature is available to users with the STANDARD license. 

 

New engine benefits 

The list of benefits are the following ones: 

 

▪ Significant gain of performance: 

a) A gain from 1.5x to 20x in some complex scripts has been measured. 

b) In particular, the pre-defined script Curb Extraction is significantly accelerated (20x). 

 

▪ Renewed and modernized documentation 

a) Standardized description of functions 

 

 
Example of the description of script function 

 

b) Better style, dark and bright themes supported in the documented API 
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Light mode 

 

 
Dark mode 

 

c) Direct link to GitHub 

 

 
 

▪ New debugger 
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a) Full support of light/dark theme 

b) More advanced capabilities for debugging (custom breakpoints, evaluation console, callstack, 

variable watch mechanism) 

c) Based on Google Chrome DevTools 

 

▪ Improved user interface: 

a) More pieces of information are exposed to users when there are errors. 

b) Pre-suggestions for coding are exposed in the script dialog to guide users. 

c) Debugger benefits from an experience improvement. 

 

Migration guide 

To accompany users in the migration to the new script engine, a dedicated chapter explains the process 

and tips to update scripts based on the old engine in the Documentation of the script API. 

 

Users that are familiar with the ancient script API are highly recommended to read this section. 
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Extract of the new documentation explaining the migration plan 

 

Deprecated script functions 

 

With the migration to the new engine, some script functions are deprecated. This list will remain updated 

and available on the script documentation. 

 

 
Extract of the new documentation listing the deprecated functions 
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Script > New functions 

The section lists some interesting new script functions that are added with the Cyclone 3DR 2023.1 version. 

 

The new functions are available to users with the STANDARD license. 

 

Density of point clouds 

Two functions are added to colorize a point cloud according to its density. These two advanced functions 

offer a path to clean complex data and remove noisy and irrelevant areas: 

a) SCloud.ComputeDensityFromNearestPoints 

b) SCloud.ComputeDensityFromSphere 

 

This feature is available to users with the STANDARD license. 

 

Document management 

A new script function CurrentDocPath() is added to get the path of the current document. It offers better 

flexibility for any kind of script workflows. 
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Improvements 

 
▪ Analysis > Compare / Inspect:  

a. With a surface model (Mesh CAD, BIM) there is now a new option to control the 
inspection resolution of the inspected surface model (Mesh, CAD, BIM).  

 

 
 

 

 

 
2022.1 BIM Inspection (known limitation) 1         2023.1 BIM Inspection (realistic result) 

Known issue can be fixed with the new resolution feature (the missing beam above the door is not built 

and not detected with the new 2023.1 version of Cyclone 3DR inspection tools) 

 

 

 

 

 

 

 

 
b. With a point cloud: Add an option to consider surface orientation when comparing with 
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a surface object (Mesh, CAD, BIM). 

 
 

 
▪ Analysis > Measure Distance Point with other objects: Added an option to sign distances 

(positive or negative values). 

 
▪ Analysis > Measure Volume from Elevation: The graph can be customized in the report. 

 

▪ Analysis > Progress Monitoring: Report information is now completed with the user 
parameters for the definition of progress status. 

 
 

▪ Analysis > Surface Analysis: Added the possibility to generate a regular grid from an 
inspected surface and export it to AutoCAD. See detailed chapter on Gridded Inspection for 
more information. 

 
▪ Application > Generic behavior: Changed the exit shortcut of a command from ESC to 

SHIFT + ESC to prevent accidental cancellation of the results. 
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▪ Clean > Edit polyline: Added the possibility to launch the Edit Polyline command with a 
double click on a polyline or with “Edit” in the contextual menu. 

 
 

▪ Extract > Scan to Plan: Significant improvement of accuracy of the automatic extraction mode 
in matter of accuracy. Need of rework is reduced after automatic extraction. 

 
 

 

▪ File > Export Mesh to OBJ / GLB:  Improve the quality of textures generated from a color 

gradient. 

 

▪ File > Export PDF3D: Improve visual aspect of inspected mesh. 

 

▪ Licensing: 

a. CLM 2.6.2.0 is embedded with Cyclone 3DR installer. The installation of CLM is 
automatically processed. In addition, notifications have been added in the settings to 
inform users when the last version is required.  
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b. When using a server-based license, the installation of CLM 2.6.2.0 cannot be done 
during the installation of Cyclone 3DR and must be proceeded by the IT service that 
manages the company server network. Notification message is displayed to inform 
users. 

 
 

▪ Rendering: Disabled shading effect on 3D images. 

 

▪ Reverse Engineering > Edit Network: 

o Improved projection accuracy when moving a node above the mesh. 

o Prevented from picking nodes that are behind the mesh. 
 

▪ Script > Favorite scripts > BLK ARC scripts: Added support for docking station. A reference 
model can now be exported and the end of the script execution. Update JSON file structure. 
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▪ Settings: Added the possibility to set default aspects on geometrical features (axis, center) 
and polylines (arrows). 
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▪ Surface Modeling > Scan to Mesh: New User Interface > the dialog has been reviewed to 
simplify the extended choice of the meshing parameters by scanner-type. 
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▪ Surface Modeling > Extrude > Profile along a Path: 

Added the possibility to define a profile base point and a profile lean point. 

 

 
 

This improvement makes the extrusion more accurate for this feature. As a consequence, and 

prior to the usage of the feature, it is necessary to prepare the data to make sure to position the 

base point on the extruded profile. 

 
▪ Texturing > Extract orthoimage: Added the capacity to save and load settings of the 

orthoimage. 
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▪ Texturing > Smart Texture: 

a. Accuracy and major performance improvement: The resolution of the texture is 
adjusted to the resolution of images. 

b. Ability to control if the triangle orientations are taken into account during the texturing 
process. 

 

▪ Texturing > Texture from Clouds / Smart Texture: Added an option to disable the mesh 
reduction. 

 
 

 

▪ View > Viewset: The properties of viewsets now contain camera position information. 
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Bug Fixes 

 

In 2023.1.0 release: 

 

▪ Analysis > Compare Inspect Section: Fixed inversion of columns (measure and reference) in 

the detailed report. 

 

▪ Analysis > Compare Points vs Cloud: Fixed inaccuracy of deviation values in the labels table. 

 

▪ CLM: Fixed a crash that could occur while defining an invalid license. 
 

▪ Extract > Region Grow: The values displayed inside the label now use the UCS if any exist. 
 

▪ File > Export to OBJ / GLB / FBX: In some 3rd party software applications, exported textured 

meshes were displayed with unwished grooves. Fixed. 
 

▪ Report Editor: 

o Fixed a crash that could occur while editing custom data. 

o Fixed truncated characters during the edition of text fields. 
 

▪ Script functions: Following functions are fixed: 

o Folders were not deleted by ClearDoc(). 

o Removed end-of-line characters in SFile.ReadLine output. 

o SaveDoc() must use the global settings value to save or not the content of the bin. 

 

▪ Settings: Settings are now saved between major software updates. 

 

▪ Surface Modeling > Subdivide: Removed thin triangles that could be generated if the option 

“improve curvature areas” was unchecked. 
 

▪ View > 2D Preview: Fixed the number of decimals and improved offset of the grid texts. 

 

 

Deprecated features 

 

Leica Geosystems strives to provide support for the widest array of operating systems and file formats 

possible as is reasonable given current technologies and support from third-party partners. 

With each release, we review our list of currently supported formats and operating systems in line with 

industry trends and announced product terminations. 

 

Leica Geosystems may add or terminate support for a file format during any release. Obsolete operating 

systems will be supported for six months after their announced termination or the next major software 

release, whichever comes first. Server products will be supported in alignment with Leica’s Client License 

Manager (CLM) supported servers to guard users against incompatibility. 
 

In Cyclone 3DR 2023.1.0:  
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▪ File > Import GIF: GIF images cannot be imported anymore. 

 

▪ File > Load from BLK 360: Replaced by the wireless connection to Cyclone FIELD 360 in Desktop 

Mode. 

 

▪ Script functions: Some functions are deprecated due to the migration to the new engine. They 

are detailed in script API documentation. 

 

Generic specifications 

Leica Cyclone 3DR 2023.1 Compatibility 

Cyclone 3DR is compatible with CLM 2.5.0 and higher.  

Cyclone 3DR is compatible with JetStream ENTERPRISE 1.3 and higher.  

Cyclone 3DR is compatible with LGS files. 

Cyclone 3DR is compatible with Cyclone ENTERPRISE 2022.0 and higher. 

Cyclone 3DR is compatible with Cyclone REGISTER 360 2021.1 and higher. 

Cyclone 3DR is compatible with Cyclone IMP databases from Cyclone 6.0 or higher, however 

improved rendering will only be seen with IMPs from Cyclone 9.3 or higher. 

 

Recommended Computer Specifications 

 

Regular workflows in desktop application: 

CPU: 2 GHz Dual Quad Core i7 or higher (i5 minimum) 

RAM: minimum 16 GB or more for 64-bit OS 

Graphic Card: NVidia Quadro or GeForce 1 GB (with OpenGL support, versions 4.3 or higher) 

Operating system: Microsoft Windows 7, 8, 10, 11 (64 bits supported) 

Hard Disk: 3 GB free disk space 

 

 

Tablet device for Touch Mode: 

Microsoft Surface PRO Core i7 1.5 GHz – 16GB RAM. 

 

Minimum specifications for Auto-classification (in addition to other recommended specifications 

for the desktop application: 

RAM: minimum 32 GB  

Graphic Card: NVidia with GPU capabilities  

- Compute capability: 3.7 or higher 

- Minimum GPU memory: 4 GB 

Hard Disk:10 GB free disk space 

https://developer.nvidia.com/cuda-gpus
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CUDA® 11.6 Toolkit (from NVidia). The 11.6 version of CUDA is mandatory for Auto-

Classification. 

 

Installation and Licensing Recommendations 

Installation update Procedure  

 

1. Launch the Cyclone 3DR EXE and follow the instructions in the Setup Wizard 

 

 
 

2. Select the option to update Cyclone 3DR (or repair if you want to change installing options) 

 

 

 
3. Complete the installation by selecting “Finish”. 

 

Licensing Setup  

1. Once you have installed Cyclone 3DR, open the Client License Manager for Floating Licenses 

via Cyclone 3DR (Home/Settings/License) or via the program located here:  

Start Menu | All Programs | Leica Geosystems | Client License Manager   
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*NOTE* Be sure to choose the CLM Floating option (there are two CLM options 

and the Nodelocked CLM will not activate your license)  

2. Click “Add”.  

 
 

 

3. Enter your Entitlement ID (EID) in the field (copy / paste). To enter multiple EIDs separate them 

with a semicolon ";" and no space.  
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4. After you have entered your EID, click on the “ADD” button in the bottom right of the page 

 

 
 

5. Once your licenses are activated you can close CLM and launch or return to Cyclone 3DR.  
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6. Go to Home / Settings and select License. 

 

 
 

7. If you have entered the EID inside your local CLM, select Localhost. If the license is on a 
dedicated server, enter the server’s name in Server Address. 
 

 
 

 
8. You can select the features you want to check out from CLM. The available options to checkout 

will correspond to the options you purchased which are contained in your EID. 
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9. Once the options are selected, click on Activate license. 

 

  

Licensing 

All users with valid CCP or CCP which was valid as of 18 March 2023 for Cyclone 3DR, can run this new 

version of Cyclone 3DR. 
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All users with valid CCP or CCP which was valid as of 18 March 2023 for 3DReshaper, can run this new 

version of Cyclone 3DR with no new license required. 

 

Users with 3DReshaper licenses with expired CCP must migrate to Cyclone 3DR in order to continue to 

access updates and support. Please contact your sales or support personnel for more information.  

 

 

Known Issues 

 

▪ The Documentation Center is only available in English. 

▪ Some CAD import and export issues might happen. For example, when exporting a cloud in DXF, 

some entities might be missing. To avoid this, it is preferable to use the Send to AutoCAD option. 

▪ If DXF can be imported with a standard version, DWG requires the AEC or PRO Edition. One 

workaround is to use the 3DSend command from AutoCAD to Cyclone 3DR. 

▪ .RSH files are natively compatible with Cyclone 3DR, and the last version of 3DReshaper is 

compatible with .3DR files (with a limit on textures and CAD objects). 
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Leica Cyclone 3DR supported file formats 

Import / Export 

 

Please reference the Cyclone 3DR Technical Specification for a complete list of supported file types per 

license.  

 

 Import Export 

Point 

Cloud 

Files ASCII (*.asc, *.csv, *.xyz, *.yxz…) 

Leica Geosystems (*.pts, *.ptx) and LGS 

(*.lgs) 

Leica Nova MS50/60 (*.sdb, *.xml) 

ShapeGrabber (*.3pi) 

3DReshaper binary file (*.nsd) 

AutoDesk DXF (*.dxf) 

STL (*.stl) 

Polyworks (*.psl) 

Leica T-Scan + Steinbichler (*.ac) 

LIDAR data (*.las; laz) 

Other ASCII (*.*) 

Zoller and Fröhlich *(.zfs - *.zfc) 

PLY points without triangles (*.ply) 

ESRI ASCII (raster format *.asc) 

FARO (*.fls - *.fws) 

POLYWORKS (*.psl) 

E57 (*.E57 files) 

LandXML files (*.xml) 

DOT Products (*.dpl) 

RDBX 

ASCII FILES (*.asc, *.csv…) 

Binary files (*.nsd) 

Leica Geosystems (*.pts, *.ptx, *lgs) 

E57 (*.e57) 

IGES (*.igs) 

LAS (*.las) 

LAZ (*.laz) 

Autodesk DXF (*.dxf) 

 

Mesh STL format (*.stl) 

Binary PBI format (*.pbi) 

DXF 3Dface format (*.dxf) 

Ascii POLY format (*.poly) 

OBJ format (*.obj) 

Ascii Leica format (*.msh) 

OFF files (*.off) 

PLY (*.ply) 

GLB format (*.glb, *gltf) 

 

Ascii and binary STL format (*.stl) 

Binary PBI format (*.pbi) 

DXF 3Dface format (*.dxf) 

Ascii POLY format (*.poly) 

Vertices only (*.asc) 

DXF polyline (*.dxf) 

Ascii Leica format (*.msh) 

PLY (*.ply) 

LandXML (*.xml) 

OBJ format (*.obj) 

GLB format (*.glb) 
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FBX format (*.fbx) 

IFC / IFCSite type (*.ifc, *.ifczip) 

Contour / 

Section 

IGES format 

DXF polyline format 

Binary MLI format (*.mli) 

 

IGES format 

DXF polyline format 

Binary MLI format (*.mli) 

ASCII formats 

CAD / BIM 

Models 

IGES 

STEP 

DWG 

IFC 

RVT 

IGES 

STEP 

DXF 

Project Cyclone 3DR (*.3dr) 

DXF - DWG 

XML 

Cyclone ModelSpace View (from IMP) 

JetStream Enterprise project  

Cyclone 3DR (*.3dr) 

DXF 

PDF 3D 

SKETCHFAB 

Report  PDF 

CSV 

BCF 

Image BMP 

JPEG 

JPG 

PNG 

Ortho-image including georeferencing 

information as TXT file 

JPG 

JPEG 

BMP 

PNG 

TIF 
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Send To / Send From 

 

Cyclone 3DR provides “SendTo” features as well to import and export certain kinds of data with third-party 

products. More information is available in Cyclone 3DR documentation center (from the software help 

menu). 

 

 Send From Send To 

Point Cloud - - 

Mesh / 

Surfaces 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

Contour / 

Section / 

Points 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

AUTODESK AutoCAD 

HEXAGON MinePlan 3D 

HEXAGON BricsCAD 

CAD Model AUTODESK AutoCAD 

HEXAGON BricsCAD 

- 

Image - AUTODESK AutoCAD (ortho-image) 

HEXAGON BricsCAD 

 

The following commands in Cyclone 3DR include a direct “Send to” capacity that provides the possibility 

to export the outputs in different layers in the CAD 3rd party software product: 

 

Menu Feature Comment 

Extract Contour Lines 
1 layer for standard contour lines and values. 

1 layer for major contour lines and values. 

Extract Scan to Plan 1 layer per slice (floorplans or sections) 

Extract Virtual Surveyor 
1 layer per layer created in 3DR Virtual Surveyor 

project. 

Analysis 
Gridded Inspection 

Surface Analysis with a Grid 

Points and values on grid can be directly sent to CAD 

SW product. Sent to active layer. 

Texturing Extract Orthoimage Sent to active layer. 

Analysis 

2D Preview Export 

1 layer for 2D Grids 

1 layer for inspection objects 

1 layer per section 

1 layer per axis points 

1 layer per axis point quotations. 

Coord Sys 

Tank 
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Compatibility with native JetStream point clouds 

The following commands can use native JetStream point clouds (LGS files or connection to Cyclone 

CORE, Cyclone REGISTER 360, Cyclone ENTERPRISE) as inputs. In other words, it is not required to 

proceed a CloudWorx > Convert project step prior to execution of the listed features. 

 

 

Menu Feature Comment 

Extract Virtual Surveyor 

Note that a selection is not required for this feature. 

Thus, it can used for any kind of objects in an 3DR 

project. 

Surface 

Modeling 
Scan to Mesh 

A clipping box as input is recommended to define an 

area of interest. 

Analysis Stockpile  

 

The functionalities of the menus View, CloudWorx and Script can obviously be used for JetStream point 

clouds. 

 

Point clouds with classification 

Classification of point clouds is saved and supported after Import/Export for the following formats: 

 

E57, LAS, LAZ, LGS 
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Export BCF tickets 

The following commands embeds the capacity to export BCF (BIM Collaboration Format) files that contain 

information from IFC model for an open-BIM experience with other software and BIM solutions. 

 

Cyclone 3DR 2023.1 support BCF 2.1 format (export). 

 

Menu Feature Comment 

Analysis 
Inspection Notes / 

BCF 

Input: Inspected BIM Model 

 

Feature to report issues from an inspection and that gives the ability to create 

manual notes that contains screenshots, images from disk, labels and 

deviation values (attached CSV), clipping object information and coordinates 

and orientation of viewpoint ; but also a user-defined title, an assignment (email 

address), a comment and a priority. 

 

Analysis Clash 

Input: A point cloud and a BIM Model 

 

Feature to report clashes that contain screenshot, clash status (clash, no clash 

or undefined) and a comment. 

All tickets refer to the same assignment (email address). 

 

Analysis 
Progress 

Monitoring 

Input: A point cloud and a BIM Model 

 

Feature to report the progress monitoring analysis. 

Default export contains a summary (progress distribution between installed, in 

progress, not installed and no data). 

Ability to customize the export and to create additional single tickets per 

analyzed element depending on their status (installed, not installed, in 

progress). 

All tickets refer to the same assignment (email address). 

 

 

 


